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Veevõrgu simulatsiooni tulemuste integreerimine BIM/GIS 
rakendustesse (Autodesk InfraWorks) 

Selles näites vaatled sa ühte lihtsat võtet, kuidas veevõrgu mudeli analüüse kuvada ehitusinfo 
mudelites (BIM) või genereerida 3D objekte lähtuvalt veevõrgu mudeli elementide tüüpidest. 
Ehitusinformatsiooni modelleerimine (ingl building information modelling ehk BIM) on ehitussektoris 
laialt kasutust leidnud protsess, milles on kaasatud nii mudelite graafiline (visuaalne) kui nendega 
kaasnev atribuutinfo. Selle kaudu matkitakse tegelikkust digitaalse infomudelina. Nii nagu 
kalibreeritud mudel esitab arvutuslikult tegelikku veevõrku, siis ehitusinfo mudel on selle laiem esitus, 
kus on kaasatud ka näiteks kontekst (maapinna mudel, sõiduteed, hooned, pargid jne). Atribuutinfot 
kasutatakse ennekõike haldamises seotud tegevustes, seetõttu tuuakse ka välja, et sõltuvalt projekti 
staadiumist muutub tasakaal graafilise informatsiooni ning atribuutinfo vahel. Antud näite eesmärk on 
visualiseerida WaterGEMS mudelis saadud arvutuslike tulemusi (nt vabasurve sõlmes) infrastruktuuri 
ehitusinfo mudelis. Lisaks arvutustulemustele saab üle kanda ka visuaalset poolt, kuid peame 
arvestama asjaoluga, et tihtipeale võidakse visuaalne/graafiline pool olla genereeritud juba 
projekteerimistarkvaras. Selles näites loome nii visuaali kui ka arvutusliku poole WaterGEMS mudeli 
baasil.  
 
Lähteandmed 
Antud näites kasutatakse varasemalt loodud Bentley OpenFlows WaterGEMS mudelit (hüdrauliline 
mudel), Autodesk Civil 3D-s olevat pinnamudelit ning lisafaile, mis aitavad andmeid konverteerida 
ühelt platvormilt/teenuselt teisele.  
 
InfraWorks mudeli loomine  
Ava InfraWorks tarkvara. Kasutades Model Builder funktsionaalsust ning varasemalt eksporditud 
shapefile baasil loo uus InfraWorks mudel (kaardiruudust, milles oled oma WaterGEMS mudeli 
loonud). 
 

1. Olles valinud sätte Import a polygon, valinud *.shp ning *.prj failid, peaksid nägema 
perimeetrit loodava mudeli alast.  

 

 
 

2. Anna mudelile nimetus Model Name kastis (siin näites PG00-455405), pane kohe paika ka 
koordinaatsüsteem, kliki None Selected ja valid Eesti koordinaatsüsteem kui Estonian 
Coordinate System of 1997. 
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3. Kliki OK, et dialoogist väljuda, seejärel Create Model. 
 
Märkus: Koordinaatsüsteemi on varasemalt olnud võimalik muuta ka hiljem, nüüd kus 
koordinaatsüsteem pannakse koheselt loodavale andmebaasile, seda muuta ei saa. Kui mingil põhjusel 
peaksid seda soovima siiski teha, siis tasub alguses koordinaatsüsteemi mitte paika panna ja teha seda 
hiljem kui mudeli andmebaas juba loodud.  
 

4. Sulle kuvatakse teavitus, et mudelit on hakatud looma. Võid selle dialoogi sulgeda.  
5. Sulge ka Model Builder aken. Jää ootama, kuniks töölauale tekib mudeli nimetusega kastike, 

mis näitab, et mudeli saab pilveteenusest alla laadida (antud näiteks kui BIM-veesektoris-
demo). 

 

 
 

6. Tee värskelt loodud mudelil vasak klikk. Sulle pakutakse variante, et kas see mudel luuakse 
Autodesk Docs keskkonda või soovid seda esmalt salvestada lokaalselt. Pane tähele, et 
lokaalsete mudelit on võimalik hiljem samuti sünkroniseerida Autodesk Docs keskkonda (vt 
eraldiseisvat juhendit). Juhul kui on ligipääs Autodesk Docs keskkonnale, vali Autodesk Docs. 
 

 
 

7. Saad nüüd valida sulle eraldatud ligipääsuga kataloogi. 
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8. Kliki OK. Toimub mudeli lokaalse osa alla laadimine ning samas ka veebikataloogi 
sünkroniseerimine. Kui kuvatakse teavitus, et mudel on sünkroniseeritud, võta teadmiseks, 
kliki OK (siit hetkest alates saad juba vaadata ka InfraWorks mudeli veebiversiooni otse 
Autodesk Docs kataloogist). 
 

9. Peale mudeli laadimist peaks avanema analoogne pilt. 
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Maapinna objekti asendamine 
Vali Manage > Content > Data Sources. Selle paani kaudu integreerime teisi faile/andmeid.  
 

1. Avanevas dialoogis kliki Import hüpikul, vali Autodesk Civil 3D DWG, seejärel osuta failile, 
milles on varasemalt loodud Civil 3D maapind (Surface).  

 

 
 

2. Fail lisatakse teiste andmete nimekirja, kuid see on veel konfigureerimata (allpool esile 
tõstetud). 

 

 
 

3. Tee sellel topelt klõps, kuvatakse dialoog. 
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4. Seaded on paigas, pane ka tähele, et failist leitakse üks pinnaobjekt (vastava nimetusega, mille 
oled varasemalt andnud). Võid vaadata paane Geo Location, et veenduda õiges 
koordinaatsüsteemis. Koordinaatsüsteem on kõige alus, et andmed tuleksid õigesse kohta. 
Kuna Civil 3D-s on see juba paika pandud, siis peaks kõik olema korras.  

5. Kliki Close & Refresh. Kuvatakse teavitus, et loodud pinnaobjekt on kategoriseerimata ja 
seetõttu ei ole see nähtav. Me peame olemasoleva pinnaobjekti peitma ja uue (täpsema) 
tegema nähtavaks.  

 

 
 

6. Kliki eelnevas dialoogis Yes, et liikuda kohe Surface Layers dialoogi, mille leiad edaspidi 
Manage > Display sektsioonist.  

7. Kuvatakse dialoog Surface Layers. 
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8. Algne maapind on esitatud kui elevation. Uus maapind aga selle nimetusega, mis oli ka Civil 
3D failis (hetkel: Surface1).  

9. Hoides vasakut nuppu all, tiri Surface1 Ground Surface sektsiooni (sinna samasse, kus juba on 
ka elevation). Seejärel kliki Surface1 osas lambipirn kollaseks ja elevation osas halliks (lülitab 
kuva välja). 

 

 
 

10. Kliki Apply, seejärel OK. Uus maapind on mudelisse toodud, mis baseerub antud juhul Maa-
ameti LiDAR kõrguspunktidel. Analoogselt saaksid sisse tuua mistahes mõõdistusel baseeruva 
maapinna. Soovi korral saad kasutada ka Autodesk ReCap funktsionaalsust, tuues esmalt sisse 
punktipilve ja luues InfraWorks töövahenditega maapinna objekti.  
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Maa-ameti fotokaardi lisamine 
Maa-ameti fotokaardi lisamiseks on vaja teostada päring kaardiruudu koordinaatide järgi Maa-ameti 
serverisse ja seejärel saame alla laadida ka aerofoto. Siin, InfraWorks tarkvaras, nõuab see lisafaili 
seadistamist, mis selle päringu eest hoolt kannab.  
 

1. Ava Maa-amet.xlsx fail. 
2. InfraWorks tarkarast saad kaardiruudu koordinaadid kätte Manage > Model Properties 

dialoogist. 
 

 
 

3. Kanna need numbrid Excelisse, pane tähele, et õige numbri õigesse kasti kirjutad. 
 

 
 

4. Ava fail Maa-amet-fotokaart.xml (ava tavalise Notepad rakendusega). 
5. Lisa Excelis toodud numbrid vastavasse sektsiooni. 
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6. Salvesta fail ning Impordi InfraWorks tarkvarasse kui Raster. 
 

 
 

7. Peale faili importi tee topelt klõps vastaval real, et see konfigureerida. 
 

 
 

8. Kliki Close & Refresh (seadistusi muuta ei ole vaja). Sul on nüüd 2 fotokaarti. Ühe, algse, 
peidame ära.  

9. Kliki Manage > Display > Surface Layers. Pane tähele rida Maa-amet-fotokaart.xml. 
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10. Rida imagery on algne fotokaart. Pane see lambipirnist kinni (hallikaks). 
 

 
 

11. Kliki Apply ning sulge dialoog OK valikust. Uus maapind koos Maa-ameti fotokaardiga on 
kuvatud. 

12. Siinkohal tasub kontrollida, kas näed Maa-ameti rasterpildi logo mõnes asukohas (neid on 
mitmeid, ja peaksid suurendama mudelit, et seda näha). 
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WaterGEMS tarkvarast eksport – torule lisaväljade tekitamine 
 

1. Loo esmalt uus stsenaarium, mis baseerub Base stsenaariumil. Nimeta see kui BIM. 
 

 
 

2. Veendu, et Active Topology = Pump+Mahuti. Physical osas kasuta Pump+Mahuti alternatiivi. 
Veendu, et ka ülejäänud alternatiivid järgiksid stsenaariumi Pump+Mahuti omasid. 
Arvutusseaded vali aga EPS+tulekahju, kuna seal on meil tipptunni tarbimise ajahetk arvutuse 
algusaeg (siin näites on selleks 20:00). 

 

 
 

3. Vali: Tools > User Data Extensions 
4. Avanevas dialoogis tee parem klikk Pipe real, vali Add Field. 
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5. Järgides allolevaid pilte, loo 2 parameetrit nimetustega Elev1 ning Elev2, need tähistavad meie 
torude alg- ja lõpp-punkti lähtuvalt arvutustulemusest. Sisuliselt siis maapinna kõrgusmärk 
saadakse kui (HGL – Pressure)/0.998. 

 
Elev1 osas: 

 
  

Elev2 osas: 

 
 

6. Veendu, et varasemast moodulist eksisteerib sõlmede filter, millega saab valida 
veemõõdusõlmed vs kõik ülejäänud sõlmed. Näiteks, allolevalt on loodud FlexTables > 
Junctions tabelis filter, mis kuvab vaid veemõõdusõlmed (varasemalt defineeritud Zone 
väärtusena). Parem klikk Zone veeru pea, valik Filter > Custom… 

 

  
 

13. Dialoogis Query Builder – Junction, tee esmalt topelt-klikk vasakust veerust leitava Zone 
omaduse peal, see lisatakse allolevasse aknasse. 
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14. Kliki keskmises osas = märgi peal, markeerimaks, et soovid kontrollida Zone väärtuse 
vastavust. Seejärel juba paremas sektsioonis rohelisel noolel, mis otsib olemasolevaid 
väärtuseid, hetkel üks leitakse ja tee topelt klikk Veemõõdusõlm nimetusel. Seejärel 
moodustub filter.  

 

 
 

15. Kliki OK ja näed filtreeritud sõlmesid. 
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Märkus. Filtri saad tühistada, kui teed uuesti Zone peal parema kliki ning valid Filter (Active) > Reset.  
 

 
 
Märkus. Pane tähele, et see eemaldab filtri. Kui soovid filtrit edaspidiseks kasutamiseks tasub kasutada 
By Query… valikut. Aga esmalt pead selle looma teise kasutajaliidese kaudu (View > Queries). Seejärel 
on seda lihtne uuesti taaskasutada. 
 
Märkus. Sul on nüüd 4 liiki elemente (tavasõlmed, veemõõdusõlmed, torud ja üks mahuti), mille 
ekspordid shapefile, et saaksid kasutada seda InfraWorks mudelis (reservuaari, pumpa seekord ei 
ekspordi). 
 

7. Arvuta oma mudel läbi ning vali päevane maksimaalne tarbimistund: Base Calculation Options 
> Start Time > 20:00:00. 

8. Vali: Home > FlexTables > Junctions 
9. Vali filtrina vaid veemõõdusõlmed 
10. Avanevas dialoogis kliki vasakus nurgas oleval nupul Export to File…  

 
Märkus: Pane tähele ka kollaseid veergusid (arvutuslikud), need ei saa olla N/A. Siis võib tekkida 
probleeme hiljem kui vaja tulemusi kuvada InfraWorks tarkaras. 
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11. Loo uus kataloog, kuhu salvestad oma shapefile sisu. Näiteks kataloog pealkirjaga shapefiles. 
Anna nimetus kui hydrants.shp. 

12. Kuvatakse dialoog, mis parameetrid soovid shapefile kaasata. See on oluline etapp olukorras, 
kus soovid kindlat sisu teha kättesaadavaks mõnes GIS rakenduses (sh arvutuslikku 
parameetrit). 
 

 
 
Märkus: Selles tabelis saad parameetritele anda oma enda nimetuse, et hiljem oleks lihtsam neid 
valida. Meie siinkohal seda ei tee. 
 

13. Kliki OK. 
14. Nüüd on meil vaja sama teha nende sõlmedega, mis pole veemõõdusõlmed. Siinkohal on 

mitmeid variante, kuidas me need valida saame. Jätkame dialoogist, kus meil hetkel valitud 
VAID veemõõdusõlmed. Klikime Select in Drawing nupul. 
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15. Seeläbi valitakse need sõlmed meie mudelis. Sulge sõlmede tabel. Sõlmed jäävad endiselt 
valituks. Kliki riba paanil Home > Selection Sets 

 

 
 

16. Loo valitud sõlmedest valikugrupp, parem klikk Selection Sets peal > Add > Selection Set. 
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17. Nimeta kui Veemõõdusõlmed. 
 

 
 

18. Tühista sõlmede valik. Ning vali kõik sõlmed (Selection Sets dialoog on endiselt avatud). 
Seejärel parem klikk Veemõõdusõlmed peal ning vali Remove from Current Selection.  

 

 
 

19. Veemõõdusõlmed eemaldatakse valitust, mis oligi meie eesmärk. Nüüd loo uus Selection Sets 
ja nimeta see kui Tavasõlmed.  

 

 
 

20. Seeläbi oleme loonud kaks olulist filtrit, mis aitavad meil sõlmi filterdada. Muidugi oleks võinud 
teha seda ka läbi Zone valiku, kus määrame ülejäänud sõlmedele muu väärtuse (nt Tavasõlm). 
Peamine, et kasutaksime ära töövahendeid, mis hõlbustavad meil hiljem neid valikud, mida 
pidevalt kasutame, teostada. 
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21. Kui nn tavasõlmed on valitud, tee joonise alas parem klikk ning vali Edit Group… 
 

 
 

22. Seejärel vali Junction Table. 
 

 
 

23. Pane tähele, et nüüd kuvatakse vaid need sõlmed, mis pole veemõõdusõlmed. Sarnaseid 
töövõtteid võid kasutada, et kiirelt määrata neile sõlmedele ka Zone väärtus. Samas Query 
võimaldab kasutada ka valikugruppe (Selection Sets).  
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16. Korda nüüd sama tegevust, mis veemõõdusõlmedega, ehk siis vali filtreeritud sõlmede dialoogi 
vasakust ülanurgast Export to File… salvesta shapefile kui junctions.shp. 

 

 
 

17. Vali näidatud parameetrid. 
18. Ava nüüd mahutite (Tank) tabel ja teosta sama, shapefile nimeks võid panna veetorn. 
19. Ava nüüd torude tabel. Lisa sinna 2 lisaveergu: Elev1 ning Elev2. 

 

 
 

20. Veendu, et need oleksid ka arvutatud. Ekspordi shapefile faili kui pipes.shp. 
 

 
 

21. Veendu, et parameetrite valikus on ka read Elev1 ning Elev2 
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22. Kui kuvatakse veateade, et osad parameetri nimetused on liiga pikad. Lühenda. Näiteks:  
 
• Length_(Scaled) = Length_S 
• Start_NodeID = Start_ID 
• Stop_NodeID = Stop_ID 

 
23. Sul on nüüd 4 komplekti shapefile sisu: 
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InfraWorks – torude andmed 
Liigu InfraWorks tarkvarasse.  
 

1. Vali Data Sources: Import > SHP 
 

 
 

2. Hoides all CTRL klahvi vali kõik 4 shp faili, mille eelnevalt oled loonud. Kliki Open. 
 

 
 

3. Need lisatakse Data Source paletile, kuid nagu ikka, on konfigureerimata. Teeme seda 
ükshaaval. 

4. Esmalt sõlmed: Tee topelt klikk junctions.shp peal. 
 

 
 

5. Kuvatakse dialoog, kus saame valida atribuutinfo, mida kasutatakse sõlmede visualiseerimisel. 
Tee järgmised valikud: 
 
• Type = Pipeline Connectors (mõjutab, mida saame hakata valima allosas, parameetrid / 

seosed jne). 
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• Paanil: Geo Locatiom, vali ka siin: Estonia97.Estonia 
 

 
 

6. Paanil Common: 
 
1. Name = LABEL (see annab sõlmele sama nimetuse, mida kasutasime ka WaterGEMS 

tarkvaras) 
 

 
 

7. Kliki Close & Refresh. Vastav andmeallikas liigub nüüd õigesse sektsiooni ning andmed 
kuvatakse mudelis. Kui suurendad mõnele tänavale, siis pane tähele siniseid “kaevusid“. Kuna 
me ei sidunud ühtegi atribuuti, siis automaatselt kuvatakse sõlmede info maapinna mudeli 
peal. See annab meile küll n-ö liitmike asukohad, kuid reaalseid kaevusid seal ei ole. 
 

 
 

8. Kui pöörad mudeli n-ö maa-alla, siis pane tähele, et sõlmedel puudub õige kõrgus, sõidutee 
pinnal kuvatakse lihtsalt sümbolit null-kõrgusega. 
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9. Tegelik sõlmede kõrgusmärk peab ilmselgelt jääma maapinna alla (nt ca 1.5 – 2 m maapinnast). 
Meil see info hetkel puudub. Sest ka WaterGEMS mudelis ei ole meil maapinna kõrgusmärki.  

10. Kliki uuesti junctions real. Proovime nüüd kuvada atribuutidest vabasurve (Pressure) ja seda 
viisil, et see algab sõlme kõrgusmärgilt (WaterGEMS tarkvaras oli selleks parameetriks 
Elevation).  

11. Esmalt paanile Source ja märgime, et meie vaikimisi kõrgusmärk on 0 m kõrgusel (mitte 
sõidutee pinnal). Seega Set Elevation = 0. 
 

 
 

12. Liigume nüüd paanile Common ja valime järgmised lisasätted: 
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13. Valime Elevation Offset = ELEV (sellega tõstame sõlme kõrgusmärgi nüüd tema õigele 
kõrgusmärgile). Kuna sellest punktist alates soovime kuvada vabasurvet omakorda 
vedelikusambana, siis märgime: Height = P/0.998 

 
Märkus: Viimase arvutusega teisendame rõhu vedelikusambaks (p = ρgh, seega h = p/0.998 – see 
tuleneb mõistagi sellest, mida me kasutasime ka WaterGEMS tarkvaras). 
 

14. Klikime nüüd Close & Refresh. Peaksime saama sarnase tulemuse. 
 

 
 

15. Kui liigud taas maa-alla, siis pane tähele, et sinine post algab sellelt kõrgusmärgilt, mis on 
Elevation väärtus olnud ka WaterGEMS tarkvaras. Seega näitame me vabasurvet just nimelt 
toru teljest. Kui aga peaks selguma, et see hakkab maapinnalt, siis ilmselt oled jätnud 
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WaterGEMS tarkvaras sõlmed valele kõrgusele (nende kõrgusmärkidest tuli maha võtta 1.8 
m). 

 
16. Teeme nüüd topelt-kliki ka hüdrantide andmereal. Ehkki hüdrantide juures võiksime teha seda 

sama, mida sõlmede juures, teeme siin väikese erinevuse. Nimelt seome hüdrandi asukohaga 
ära olemasoleva 3D objekti, mis kujutab hüdranti. Selleks teosta järgmised muudatused: 

 
• Type = City Furniture 
• Name = LABEL 
• Geo Location paanil vali kindlasti Estonia97.Estonia 
• Style, Rule Style real kliki pliiatsi ikoonil ning vali Fire Hudrant – Red. Kliki OK. 
• Kliki Close & Referesh 

 

 
 

17. Navigeeri mudelis ringi ja otsi mõni hüdrant. Kuna hüdrandid esitavad meie tavapäraseid 
sõlmi, mida üldjuhul paigutasime sõidutee telgjoonele, kuvatakse need nüüd ka meie mudelis 
keset sõiduteed. Lisaks mõjutab paigutust ka sõidutee laius, mis siinkohal kasutab vaikimisi 
sõidutee tüüpi (sh laiust, sõiduradade laiust jne). Samas on meil võimalik kõike muuta ja 
täpsustada, mis on ka ehitusinfo modelleerimise oluline osa (staadiumite kaupa täpsustatakse 
andmeid, lisatakse atribuute jne). Näiteks, hüdrant lisatakse lisaelemendina WaterGEMS 
mudelis kui lisaharu sõidutee telgjooonest lähtuvast sõlmest nii, et see tekib teepervel.  
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18. Sarnaselt teeme ka topelt-kliki veetorn andmereal. Kaasama ka siin vaikimisi InfraWorks 3D 
mudeli komponendi. 

 
• Type = City Furniture 
• Name = LABEL 
• Geo Location paanil vali kindlasti Estonia97.Estonia 
• Style, Rule Style real kliki pliiatsi ikoonil ning vali Water Tower. Kliki OK. 
• Kliki Close & Referesh 

 

 
 

19. Navigeeri mudelis ringi ja leia oma veetorn.  
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Märkus. Klikkides veetorni komponendil, saad ülemisest noolest selle skaalat muuta, et see esitaks 
enam-vähem seda, mida võiks oodata lähtuvalt vabasurvetest.  
 

 
 

 
 

20. Teeme topelt-kliki nüüd torud andmereal. Teosta järgmised põhiseadistused: 
• Type = Pipelines 
• Name = LABEL 
• Geo Location paanil vali kindlasti Estonia97.Estonia 
• Elevation sektsioonis vali Elevation (Pipe Invert) ning seadista toru algus ja lõpp kui ELEV1 

ning ELEV2. 
• Sektsioonis Size vali parameetrina D (tähistab toru läbimõõtu millimeetrites) ning muuda 

kindlasti ära ka ühik, mis on mm. 
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21. Kliki Close & Refresh. 
22. Kui vaatad maa-alla, pane tähele, et torud on lisatud õigetele kõrgusmärkidele, sealt kust 

algavad sinised postid. 
 

 
 
Märkus: Kui need ei hakka õigelt kõrguselt, siis on ilmselt viga selles, et WaterGEMS mudelis on ELEV1 
ning ELEV2 valesti arvutatud.  
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Märkus. Sellega oled proovinud tööprotsesse, kuidas analüütilisi andmeid siduda ehitusinfo 
mudelitega. Selle eesmärk võib olla erinev. Kas siis visualiseerimiseks (kus nt vabasurve on piiratud või 
ka lihtsalt GIS andmete üle toomiseks ühelt platvormilt teise). Sul on võimalik jätkata 
visualiseerimisega ka viisil kus vabasurvete “poste“ näidatakse erinevates värvitoonides või 
läbimõõduga (lähtuvalt näiteks vabasurve suurusest). Soovides teatud liiki andmete esile tulemist, 
saad omakorda näiteks hoonete visuaali tahaplaanile jätta (muutes ära nende fassaadide esitusstiili). 
Lisaks saad kasutada erinevaid stsenaariumeid (InfraWorks tarkvaras kui Proposal), et esitada 
erinevaid andmeid ühes ja samas mudelis. 

Märkus. Kui soovid kajastatud muudatusi kanda üle ka veebipõhisesse InfraWorks vaatesse (Autodesk 
Docs), siis pead kasutama Sync nuppu.  

 

Kuvatakse võrdlus olemasoleva seisuga, millest lähtuvalt saadki otsustada, kas tehtud muudatused on 
kajastatud või veel mitte ja seega pead need kehtestama ka veebiversioonis. 

 

Peale sünkroniseerimist kuvatakse teavitus, et see on nüüd kättesaadav teistele projektis osalistele. 
Pane tähele, et veebipõhine vaade ei pruugi olla kohe valmis kui sünkroniseerimine on arvutist 
teostatud, seda näitab ka Autodesk Docs vastav vaade. Pane tähele, et iga uus sünkroniseerimine loob 
ka uue veebipõhise versiooni (siin näites V3). See tähendab, et sul on võimalik vaadata ka varasemaid 
seise, kui klikid versiooni tähise peal. 
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